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[[tems to Prepare]

[tems to prepare

1. A computer with any of the following versions of PowerPoint installed
Windows: PowerPoint 2010, 2013, 2016, 2019, or Office 365

*Mac : PowerPoint 2019 for Mac, or Office 365

2. A microphone (an environment capable of voice input)

While it is possible to record using the built-in microphone, we recommend you
use an external microphone, such as a headset with a microphone, because the

built-in microphone will also pick up ambient sound (noise).
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[[tems to Prepare]

[tems to prepare

3. Creation of presentation data

Select the slides you want to include in your video.
All slides will be included in your video unless they are hidden.

Use the Hide Slide option for any slides you do not want to include in your

presentation.

{ Notes)

- Thereis no limitation on the number of slides in your PowerPoint presentation.

. Thevideo length is the talk duration assigned to you.

. It is mandatory to include the Conflicts-of-Interest (COIl) Disclosure on the 2" page of
your slide.
(Reference: https://www.neurology-jp.org/gaiyo/pdf/riekisouhan_unyoukitei.pdf)
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How. to check your microphone in Windows

(common to all versions)




. . . [Windows#t@] v/ U DFER A A
How to check your microphone in Windows

Click Start > Settings > System > Sound, and check that your input device is registered. Try
speaking, and check that there is a response under “Test your microphone.”

& Settings
. . (@ Home
Windows Settings SOU nd
I Find a setting Je, If your input device is
— jivput displayed in the pull-down
System menu, then it is registered
£ ices D Pho Choose your input device
< mouse Link -
LJ  Display Microphone Array (Realtek Audio) v
A \\‘> — e et
ertain apps may be set up to use aiirerent soun evices than thq
8 Pictures 98 Seund (4) Sound selected here. Customize app volumes and devices in advanced so
options.
[} Notifications & actions Device pitmerin
(2) Settings Settings p
Power “Test your microphone” g =
O | when you try speaking, then
; : ; /\ Troubleshoot
é your microphone is working
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[Windows] PowerPoint 2019 - Office 365

A. Guideline for Windows PowerPoint 2019 = Office 365

(1) Select the “Slide Show” tab | [ (2) Click “Record Slide Show”

(5) Click “Record” to start recording

Slide Show Rzview View Help Q Tell me what you want to do

Play Narrations

./ ® o
Use T
Rehearse Record Slide [_] Use Timings

Timings = Show~ || Show Media Controls

[Er]-'j Monitor; Automatic

[:] Use Presenter View

Presentation Slide

sample

Ed Record from Current Slide... Monitors

ord from Beginning...
L.CSTEDNINAL ANTILINCI ARMMMATNADRV
>

endomi

Inparti Record narrations, ink, laser pointer

Record from Beginning

(3) Click “Record from Beginning”

ZZ B0 0DONEREREOE & =

(4) If the internal camera is enabled, images from
this camera will also be recorded in the pop-up
window. Therefore, please turn this camera off.



[Windows] PowerPoint 2019 - Office 365

A. Guideline for Windows PowerPoint 2019 = Office 365

(6) Record your narration using a microphone as you advance

the slides

(Audio recording will be interrupted at the title slide and when (7) Once you reach the screen below, recording

advancing to the next slide. Therefore, once a slide appears, pause a will automatically stop. Advancing to the next slide,
moment before you start talking.) will return to you to the editing screen.

Presentation Slide

sample

End of slide show, click to exit.

zZ B 00ONEREROOE BOOONERENCODE

Click “Stop” to save your progress Click the arrow or anywhere on the
slide to advance to the next slide

Click “Pause” to pause recording




[Windows] PowerPoint 2019 - Office 365

A. Guideline for Windows PowerPoint 2019 = Office 365

File

ﬂ

Preview

Home

Insert

sample

Design

Transitions

Presentation Slide

* 00:05

Animations Slide Show Review View Help
A 4 = |
Transition to This Slide
NON-STERO

Peptic ulceration may re

L——A y . —‘A o 2 ’A although if taken for 5 ¢
2 * 00:06 3

endometriotic lesions bi
In particular. the pain a¢
prostaglandin synthesis
cyclo-oxygenase and th
reduce pelvic pain.

The commonest non-ste
naproxen, which can be
Mefenamic acid is avail.
treatment of dysmenorr
The main side-effects a

(8) Once you have reached the final slide and finished the slide show, select the “View” tab and click
“Slide Sorter” to show thumbnails of all your slides. Check that a time is shown at the bottom right
corner of each slide, and save the PowerPoint (as a new file).

Open the file again and start the slide show to check whether the timing of audio and slides is OK

If there are any problems, record the audio again from the relevant slide

Copyright © 2021 Convention Linkage, Inc. All Rights Reserved. 9



[Windows] PowerPoint 2019+ Office 365

A. Guideline for Windows PowerPoint 2019 = Office 365

(7) If there are no problems after checking the slides, export your video

File > Export > Save & Send > Create a Video

Export Export

Create a Video [l Create PDF/XPS Document Create a Video

-
Lﬁ- Create PDF/XPS Document ) , ) , Save your presentation as a videa that you can burn to a disc, upload to the web, or email
. Save your presentation as a video that you can bum to a disc. upload to the web, or email .
o ) . ¥ Incorporates all recorded fimings, narrations, and laser pointer gestures
¥  Incorporates all recorded timings, namrations, and laser pointer gestures e Create a Video . P e A
. resernves animations, transitions, and media
‘,i:l Create a Video W Preserves animations, transitions, and media B
© Get help buming your slide show video to DVD or uploading it to the web

@ Get help bumning your slide show video to DVD or uploading it to the web P
AT> . ,]:: Package Presentation for CD
pod Package Presentation for CD 4

L = Internet Quality
= Medium file size and moderate quality (1280 x 720)

-m Presentation Quality -
Largest file size and highest quality (1920 x 1080)
['F 7| Presentation Quality
2| Largest file size and highest quality (1920 x 108D}

E¥  Create Handouts

LY create Handouts ‘ m Use Recorded Timings and Narrations

Slides without timings will use the default duration (set below). This option includes ink and laser point... T

H- Change File Type [ Don't Use Recorded Timings and Narrations

H Change File Type Internet Quality I0® Al slides will use the default duration set below. Any narrations will be omitted from the video.
Medium file size and moderate quality (1280 x 72
S § GG 3 - Use Recorded Timings and Narrations
lfﬁ ]| Low Quality ) Slides without timings will use the default duration (set below). This option indudes ink and laser pointer gestures,
' Smallest file size and lowest quality (852 x 480)
Create &b Record Timings and Marrations
Video

T Preview Timings and Narations

For video resolution, select [1280 x 720] Select “Use Recorded Timings and Narrations”

Finally, as soon as you click “Create a Video,” the “Save As” window will appear.
Specify the file name, and select [MP4] for the file format.

Click “Save” at the bottom right to create the video and save it automatically.

Progress of the video creationis shown at the lower right.

* Creating a video in HD quality (1280 x 720) from a 20-minute slide show takes about 20 minutes.

Copyright © 2021 Convention Linkage, Inc. All Rights Reserved.
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[Windows] PowerPoint 2013-2016

B. Guideline for Windows PowerPoint 2013-2016

(1) Select the “Slide Show” tab (2) Click “Record Slide Show”
MmATIE (A7 109.pptx - PowerPoint ey e e e e =
inflammatory drugs mvhibit cyclo-oxygena;e lfgd therefore reduce

ibuprofen and naproxen, which can be bought over the counter.

‘ L@ (@ 7 Play Narrations Ej‘_ e P— ) Mefenamic ancidf:s available on prescription o;ﬂy, and is eﬁec:ii;‘e.isn
- Use Timings b
] Rehearse Record S'lde X Use Presenter View — “A s Record Sllde ShOW ? >< ::c
> Timings | Show~ Show Media Controls g
. . s Moni . . 3
<D Start Recording from Beginning... oniters Select what you want to record before you begin recording. *

x,
L)
O

Slide and animation timings
Narrations, ink, and laser pointer

Stag Recording from Current Slide... Start Recording from Beginning

Record narrations, ink, laser pointer

endomatriotic lesk - gestures, and slide and animation
pelvic pain, In par f | b k

is mediated by pre  timi

flasmanaey Sl tlmlngs Or playback.

prostaglandin prooucuunr enu reuuLe pevic et

The commonest non-steroidal anti-inflammatory drugs are

ibuprofen and naproxen, which can be bought over the counter.
Mefenamic acid is available on prescription only, and is effective in

the treatment of dysmenorrhoea at a dose of 500 mg three times

Start Recording

daily.
A The main side-effects are gastrointestinal, particularly gastric
irritation. Peptic ulceration may result if treatment is used for a

* 3 *

(3) Click “Start Recording from Beginning”

(4) Check that both the “Slide and animation
timings” and “Narrations, ink, and laser pointer”
check boxes are selected, and click “Start
Recording” to start recording

12
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[Windows] PowerPoint 2013-2016

B. Guideline for Windows PowerPoint 2013-2016

(5) Check that “Recording” appears at the top left and proceed with your
presentation

(Audio recording will be interrupted at the title slide and when advancing to the next
slide. Therefore, once a slide appears, pause a moment before you start talking.)

Home Insert Design Transitions Animations QEUGEEGCIE Review View '3?;.3 Tell me wt

2> Il 0:00:05 € 0:00:05

) 2 == E— [ 1/ x TN | Play Narrations
P X ¥ E=x N - o @oJ Use Thminas
From From Present Custom Slide SetUp Hide Rehearse Record Slide g
Beginning Current Slide Online~ Show~  Slide Show Slide Timings Show~ Show Media Controls
Start Slide Show SetUp
n:iem«nm
- - paivic pain
Presentation Slide fe

- commer

sample

Presentation Slide

sSam ple 1 *00:02 2 *00:05 3

4 4

(6) Once you have reached the final slide and finished the slide show, show thumbnails of all your
slides. Check that a time is shown at the bottom right corner of each slide, and save the PowerPoint
(as a new file)

Open the file again and start the slide show to check whether the timing of audio and slidesis OK

If there are any problems, record the audio again from the relevant slide

Copyright © 2021 Convention Linkage, Inc. All Rights Reserved. 13



[Windows] PowerPoint 2013-2016

B. Guideline for Windows PowerPoint 2013-2016

(7) If there are no problems after checking the slides, export your video
File > Export > Save & Send > Create a Video

Export

Lo Create PDF/XPS Document Create a Video ]
== Save your presentation as a video that you can burn to a disc, upload to the web, or email
B Incorporates all recorded timings, namations, and laser pointer gestures ol
= ot
&'_'J Create a Video B Preserves animations, transitions, and media
@ Gat help buming your slide show video to DVD or uploading it to the web ey
3;¢ Package Presentation for CD Y
Presentation Quality -
E3 Largest file size and highest quality (1920 x 1080) L':‘
[) Create Handouts f ] Presentation Quelit o
"I Largest file size and highest quality (1920 x 1080} E
Change File Type It e
& AL ke ] ek i size and modivte aualty (1260720
Bl Low Quality

Smallest file size and lowest quality (852 x 480)

Video

Export

Create PDF/XPS Document

Create a Video

Package Presentation for CD

Create Handouts

Change File Type

Create a Video
Save your presentation as a video that you can burn to a disc, upload to the web, or email
¥ Incorporates all recorded timings, namations, and laser pointer gestures

¥ Preserves animations, transitions, and media

@ Get help burning your slide show video to DVD or uploading it to the web

B Intermet Quality
=/ Medium file size and moderate quality (1280 x 720)

[:2 Use Recorded Timings and Narrations -
Slides without timings will use the default duration (set below). This option includes ink and laser point...

== Don't Use Recorded Timings and Narrations
'#1® Al slices will use the default duration set below. Any narrations will be omitted from the video.

[ Use Recorded Timings and Narrations
) Slides without timings will use the default duration (set below). This option indudes ink and laser pointer gestures.

& Record Timings and Narrations

5 Preview Timings and Narrations

For video resolution, select [1280 x 720] Select “Use Recorded Timings and Narrations”

Finally, as soon as you click “Create a Video,” the “Save As” window will appear.

Specify the file name, and select [MP4] for the file format.

Click “Save” at the bottom right to create the video and save it automatically.

Progress of the video creation is shown at the lower right.

* Creating a video in HD quality (1280 x 720) from a 20-minute slide show takes about 20 minutes.

Copyright © 2021 Convention Linkage, Inc. All Rights Reserved.
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[Windows] PowerPoint 2010

C. Guideline for Windows PowerPoint 2010

(1) Select the “Slide Show” tab

(2) Click “Record Slide Show”

t Slide Sh o the traxtment of Sysmenarrhoed 3t 3 dase of 500 mq three
ations ide Show eview Tiew daty.
- b A A e ‘ The main side-efacts are Gastraintessnal, partcularly Gast
b\) ] Play Narrations (@B Resolution: Use Current Resolution ~ : | rration. RegRic WiceraBion may result f treatment 5 used !
—
7 Use Timings i ‘ v Record Slide Show ? X

de  Rehearse |Record Sllde . -
ide  Timings | Show~ |l Show Media Controls | [] Use Presenter View

Select what you want to record before you begin recording.
[ Narrations and laser pointer

»3 Start Recording from Beginning... Monitors

" | Start Recording from Beginning Y

Record audio narrations, laser
pointer gestures, or slide and pe
animation timings for playback e
during slide show,

d inverson recover

¢ o Press F1 for more help. 2 ving muligle lao
A = T — - gradet echo ol
e TRIton. Reptic WCErIBON May result # trastment i used %or 3 ASKL pfort =} ) muligle micratioods
- 4 2 o 3

(4) Check that both the “Slide and animation
timings” and “Narrations and laser pointer” check
boxes are selected, and click “Start Recording”

start recording

(3) Click “Start Recording from Beginning”

Copyright © 2021 Convention Linkage, Inc. All Rights Reserved.
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[Windows] PowerPoint 2010

C. Guideline for Windows PowerPoint 2010

(5) Check that “Recording” appears at the top left and proceed with your
presentation

(Audio recording will be interrupted at the title slide and when advancing to the next
slide. Therefore, once a slide appears, pause a moment before you start talking.)

0:00:05 ¥ 0:00:05

m Home Insert Design Transitions Animations Slide Show Review View

- p— =) b, — = ]

© 2 | [¥] Piay Narrations
B & B R e M o E
L-) — — = —= . [T] use Timings
From From Broadcast Custom Set Up Hide Rehearse Record Slide

Beginning Current Slide  Slide Show Slide Show ~ = Slide Show Slide  Timings  Show~+ L Show Media Cor
Start Slide Show Set Up

Presentation Slide

A a o A &

sample

Presentation Slide

sample % 00:09 / 1 s 00:02 /

(6) Once you have reached the final slide and finished the slide show, show thumbnails of all your
slides. Check that a time is shown at the bottom right corner of each slide, and save the PowerPoint
(as a new file)

Open the file again and start the slide show to check whether the timing of audio and slides is OK

If there are any problems, record the audio again from the relevant slide

Copyright © 2021 Convention Linkage, Inc. All Rights Reserved. 17



C. Guideline for Windows PowerPoint 2010

(7) If there are no problems after checking the slides, export your video

File > Export > Save & Send > Create a Video

n Hom: et Desig Transitio Animat Slide Show  Review  View
b save .
Save & Send Create a Video
B savess S B : i i .
a B B Create a full-fidelity video from this presentation that can be distributed by using a disc, the Web, or e-mail.
5 open = i Send Using E-mail Incor i i
rporates all recorded timings, narrations, and laser pointer gestures
' Close Inchedes all slides not hidden in the slide show
° Save to Web Preserves animations, transitions, and media
Info
TII: time it takes to create a video vanies depending on the length and complexity of the presentation. You can
— m Save to SharePoint ontinu to use PowerPoint whilé the video is being created.
0 rrin, ¢ slide sh ¢ uploading he W
New ? Broadcast Slide Show
Print Computer & HD Displays

@ Publish Slides

File Types

Help

1] Options
3 Exit

H Change File Type

a Create PDF/XPS Document

:

For viewing on a computer monitor, projector, of high definition display (Large — 1280x 720)

@ Create a Video

For video resolution, select [1280 x 720]

Computer & HD Displays
B || Forviewing on a computer monitar, projector, or high definition display (Large — 1280 x 7201

Internet & DVO
B || For uploading to the Web and burning to standard DVD (Medium — 852 x 450)

— Portable Devices
B:l  micosoft Zune video quaiity; Small text may be difficult to read (Small — 424 x 240)

‘\fdm

Design  Transitions Animations

[Windows] PowerPoint 2010

Slide Show Review View

|l save
L saveas
(& Open
' Close

Info
Recent
MNew

Print

Fi

Help

) Options

3 et

Save & Send

Oy send Using E-mai
@ sevve
m Save to SharePoint

-—
__P Broadcast Slide Show

I:?.\J Publish Shides

ile Types

ﬁ Change File Type

l Create PDF/XPS Document

m Create a Video

Create a Video

Create a full-fidelity video from this presentation that can be distributed by using a dise, the Web, or e-mail.
Incorporates all recorded timings, narrations, and laser pointer gestures
Includes all slides not hidden in the slide show
Preserves animations, transitions, and media

The time it takes to create a video varies depending on the length and complexity of the presentation. You can
continue to use PowerPoint while the video is being created.

[ ] Computer & HO Displays
|—]r viewing on a computer monitor, projector, or high definition display (Large — 1280 x 720)

Use Recorded Timings and Namations.
Slides that do not have timings will use the default duration set below. Any recorded laser pointer gestur...

B Don't Use Recorded Timings and Namations.
All slides will use the default duration set below. Any narrations will be omitted from the video.
%

KD Record Timings and Narrations
3 Preview Timings and Narrations

Use Recorded Timings and
Slides that do not have timings will use the default duration set below. Any recorded laser pointer gestures will also be induded.

Select “Use Recorded Timings and Narrations”

Finally, as soon as you click “Create a Video,” the “Save As” window will appear.

Specify the file name, and select [MP4] for the file format.

Click “Save” at the bottom right to create the video and save it automatically.

Progress of the video creation is shown at the lower right.

* Creating a video in HD quality (1280 x 720) from a 20-minute slide show takes about 20 minutes.

Copyright © 2021 Convention Linkage, Inc. All Rights Reserved. 18
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D. Guideline for Mac PowerPoint for Mac 2019

How to check your microphone

Click System Preferences > Sound > Input, and check that your input device is registered.

Try speaking, and check that there is a response under “Settings for the selected device.”

(1) System Preferences [ ]

Check that your device is registered

Sound

Q_ Search

Sound Effects Output @ A
Select a device for sound input:

Name

MacBook Pro Microphone

. Try speaking. If there is a
- il ©

response under “Input level,”
General Desktop & Dock

Update Apple ID Settings

Type

Mlsspn Siri i i i
JDeskiop & 4 then your microphone is working.
= @ P Settings for the selected device:
}f;@ﬂ’ \I’ : :
. . _ Input volume: L_!J§ !;5
Internet Wallet & Touch ID Uferd & Accessibility ¢ CR [ « ] ' 3
Accounts Apple Pay oug Input level: 1]
>
B (2) Sound -
& @ 0|\
k i Output volume: ‘ . . . ) . ‘))) Mute
Software Network Bluetooth Sound Printers & Show volume in menu bar
Update Scanners

Copyright © 2021 Convention Linkage, Inc. All Rights Reserved.
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D. Guideline for Mac PowerPoint for Mac 2019

[Mac] PowerPoint for Mac 2019

Checking PowerPoint has access to microphone

Click System Preferences > Security & Privacy > Privacy > Microphone, and check that the
“Microsoft PowerPoint” checkbox is selected.

(1) System Preferences

System Preferences [

—
B—
oo

Mission
Control

[ X ]
&
Users &
Groups

O\}:%- 2arch

Apple ID

O 0 B

sii so (2) Security & Privacy

o

®© 0 .

Accessibility Screen Time Extensions

~

Security & Privac :
(3) Privacy

@ <ol>
Family " g .
Shaia General FileVault  Firewal
Always|
Detalls Subtitly U Reminders

Security
& Privacy

m Speech Recognition

Copyright © 2021 Convention Linkage, Inc. All Rights Reserved.

Allow the apps below to access your mi

@ Microsoft PowerPoint

Check that the checkbox
is selected
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D. Guideline for Mac PowerPoint for Mac 2019

Preparing to record in PowerPoint

Open the slides in PowerPoint, and check that the first slide is selected.

If you click Slide Show > Record Slide Show, the screen automatically switches to Presenter
View, and recording starts.

Hovering the cursor here, you
may see the comment “Start
Recording from Beginning.”

Check that the first slide
is selected

File
At Qo A HEH SO = P . .
resentation Slide

Home Insert raw Design Transitions Animations ﬂm

By 0. i % 2 sample

Play from Play from | Presenter Custom Set Up Hide Rehearse
Start  Current Slide View Show Slide Show Slide Timings

Edit View Insert Format Arrange

Click here to switch
screens and start
recording

Record

Presentation Slide

sample

Presentation Slide

[Mac] PowerPoint for Mac 2019
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D. Guideline for Mac PowerPoint for Mac 2019 Hacl Powerfont for Mac 2019

Running a slide show

12:05 Next slide

Run your slide show as normal.

You can use the pen, pointer and so on, but
ultimately, the video will only record the audio
and the timing of when you advance slides.

Presentation Slide

sample

Audio recording will be interrupted at the title
slide and when advancing to the next slide.
Therefore, once a slide appears, pause a
moment before you start talking.

Laser Pointer

Highlighter

Presentation Slide

" Pen Color
sample

Laser Color

You should note that, if you go back to the

previous slide, the recording on this slide will Even if you select a pen, highlighter or pointer
be overwritten from the menu, it will not be recorded

23



D. Guideline for Mac PowerPoint for Mac 2019 acl Powerfomt for Mac 2019

Finishing a slide show

After completing your slide show, click “End Show” at the top left. “Do you want to save
your slide timings?” will appear. Select “Yes.”

“End Show”
Summary

Endothelial injury represents a major initiating step in the pat

atherosclerosis. The identification and quantification of circula The total time for your slide show was

as a novel marker of endothelial function. As a technique, & m 0:00:11. Do you want to save the new slide
endothelial function such as flow-mediated dilation, the measi timings?

tissue plasminogen activator. Quantification of CECs is difficult

morphology, and a lack of standardization in current techniqu

population of cells to endothelial progenitor cells. Increased C

m&%&wma& o0 R et R oL RO ANSSPRR REYELY 2RdoRRRIRe

[ 1ors and endothelial nitric oxide (NO) levels in the microcirculation in vivo. | . k " n
The method is also useful to study the effect of NO replenishing therapy on adhesion of leukocytes to C I C Ye S
the vascular endothelium in acute and chronic inflammatory states of the cardiovascular system.

This research approach requires the combination of two well-established physiology techniques, that is,

intravital microscopy and real-time measurement of NO with microelectrodes.

Intravital microscopy is considered the method of choice to monitor leukocyte-endothelial cell

interactions in intact vascular beds of live animals. In vivo microscopy is currently used to study the

endothelial cell phenotype of mice carrying mutations or deletion of targeted genes. Intravital

microscopy is also used to study endothelial cell function in acute (e.g., ischemia-reperfusion injury)

and chronic (e.g., hypercholesterolemia, hyperglycemia, and diabetes) inflammatory states of the
cardiovascular system. NO Sensors allow for continuous, amperom_etric quanti_ﬁcation of NO levels in

24



D. Guideline for Mac PowerPoint for Mac 2019 Hacl Powerfont for Mac 2019
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D. Guideline for Mac PowerPoint for Mac 2019

Selecting the destination folder

Click File > Export to open the export window. Specify the filename and select where to
save the file. Under file format, selecting “MP4” will enable you to set the details.

entation N
New from Template... 3P
Home Insert D Qpen...

o e

Play from Play from F

Open Recent > I

Close #W
Re

Start  Current Slide Save #S Ti
Save As... ¢ #S

Export...
Presentat

s (2) Export

1 — k 0:01
Share >

Always Open Read-Only

), ) ( H Restrict Permissions >

Passwords... ‘

- Compress Pictures... ===

7 Page Setup... ¥ 0:00
Print 8P

Properties : _
\‘ - ﬁ\ -
; )

30 imatic

mmwmsﬁ-mmw |

port As: | A2 K (¥3-) 169 |

Tags
ere: i Desktop

”E (3) File Format: MP4

JPEG
TIFF
PNG

Timing  gmp

Rich Text Format (.rtf)
PowerPoint Add-In (.ppam)
PowerPoint 97-2003 Add-In (.ppa)

ot As: | BRZSA K (F5-) 169

ags.

b: 1 Desktop v

File Format@l MP4

Quality: Internet Quality B
Width: 1,280 Height: 720

set{
do §

I= Online Locations
-

Timing: 3 Use Recorded Timings and Narrations
Seconds spent on each slide without a set timing: 5

ol v

Copyright © 2021 Convention Linkage, Inc. All Rights Reserved.
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D. Guideline for Mac PowerPoint for Mac 2019 el PowerPont for Mac 2019

Selecting video quality, and creating and saving the video

For video quality, select “Internet Quality,” and check that the “Use Recorded Timings and
Narrations” checkbox is selected.

Click “Export” to create the video and save it automatically.

ansitio

Export As:| BBBR 51 K (¥3—) 169 |

Tags:

Set |

Side'S Where: m Desktop v Progress of the video
creationis shown at the

I= Online Locations File Format: MP4

| ight.
m (1) Quality: InternetQuallty BEETlg
Width: 1280  Height: 720 Creating a video in HD
1 (2) Timing: Use Recorded Timings and Narrations 20-minute slide show takes
N - bout 10 minutes.
_]: ‘ Cancel a
*000 9 %000 10 ;°=°5 no - o (3) EXpOrt
Ca

FE ORI Summary | Poverpoin s convring: Uloading o WRA> (- (7 ) 168mps
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Other notes: How to create an MP4 file from Keynote

B Export Keynote Presentations as a Movie
nttps://creativepro.com/export-keynote-presentations-movie/

B How To Export A Keynote Presentation As A QuickTime Video
nttps://www.ethos3.com/2015/12/how-to-export-a-keynote-
presentation-as-a-quicktime-video/

B Export Keynote Presentation to PowerPoint or Another File Format
https://support.apple.com/en-gb/guide/keynote/tana0d19882a/mac

Copyright © 2021 Convention Linkage, Inc. All Rights Reserved.
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How to Make a Video Presentation
by ZOOM Recording

=Before you record === Pg 29
= After you join Zoom meeting === Pg 31
*Recording in Zoom === Pg 33



Before you record

* Please be advised that all speakers must include a Conflicts of Interest
(COI) Disclosure on the 2" slide of the presentation.
For more details, please check the following web site;
https://neurology-jp.org/neuro2021/en/abstract/notification.html

* Please make sure to adjust your microphone correctly.
Correctly setting your microphone volume is one of the most important
Improvements you can make in your recordings.

* Please be sure to turn off phones and notifications that could cause
distractions during recording.

* |f you wish to use a webcam to record yourself during the presentation,
plug in the webcam before opening Zoom.
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Before you record

* It is highly recommended that you practice using Zoom before recording so that you are
comfortable with the controls before you record your presentation.

85 05 -

1' Open the PowerPOInt flle y File Home Insert Design Transitions Anima’ti(:»nso
2.Click Slide Show O= = Oy
. . e s B vy 1. ®
3 . CI ICk SEt U p SI I d e Sh OW From From Present Custom Slide SetUp Hide Rehearse Record Slide
Beginning Current Slide Online~  Show ~ Slide Show Slide Timings Show ~
Start Slide Show Set Up

4. Under Show Type, click Browsed by an individual (window)
* This will allow you to present in slideshow view without being in full screen mode.
Full screen mode can make recording with Zoom more difficult.

Set Up Show

. Show type Show slides
5.Click OK ’“ e "
) Presented by a speaker (full screen) @) all
(®) Browsed by an individual {window) ( ) Erom: =
6.Click Play from Start or From Beginning O Browsed ata Kosk (fullscreen)
to begin the slideshow
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After you join Zoom meeting

1. Click the ™ next to the Mute button in the lower-left corner of
the Zoom window to open audio options.
At the top of the menu that appears, select your recording
microphone if you are using something other than your
computer’s built-in microphone.

2. Click Share Screen. n
You can find the icon at the bottom of the Zoom window.

3. Inthe Share window, click the window you wish
to use in the recording.

71 IS

Start Video

4. If your presentation includes sound, check the box
for Share computer sound.

Presentation
Slide

5. If your presentation includes a video, check the box

for Optimize Screen Sharing for Video Clip. @ @ R
6. Click Share.

The window that is being shared/recorded will have a green

outline.
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After you join Zoom meeting

7. You can reposition and resize the webcam video window as needed.

The webcam feed will be recorded regardless of whether it is positioned within the green
recording border.

When a window is being “shared” in Zoom (i.e. recorded), the Zoom control bar will
minimize and move to the top of the screen. Hover over the minimized control bar to
reveal the full set of Zoom controls.
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Recording in Zoom

1. To begin recording, please click ...More in the Zoom control bar.

Wad D!

(DClick
Here

£ LA A

Start Video Manage Participants New Share Pause Share  Annotate More

2. Please Click Record on this Computer or Record to the Cloud
in the dropdown menu that appears.

*If you are muted, click Unmute myself in the window that appears.
You are now recording and ready to give your presentation.

You can pause recording at any time by clicking ...More , in the Zoom
control bar, then Pause Recording.

(or press Alt+P on Windows or 38+Shift+P on Mac)

If you are unable to control PowerPoint or Zoom with your keyboard,

first click the PowerPoint or Zoom window to focus your keyboard
commands on that window.

Chat
Breakout Rooms

Invite

Pause Recording

Stop Recording
Disable Attendee Annotation

Audio Options...
Video Settings...

Optimize for full-screen video clip
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Recording in Zoom

3. You can change the window being recorded by clicking New

Share in the Zoom control bar at the top of the screen, and

selecting the window you wish to record.

4. When you are finished, click ...More and click Stop
Recording in the Zoom control bar at the top of the screen.
(or press Alt+C on Windows or ¢8+Shift+C on Mac)

5. Click Stop Share in the Zoom bar at the top of the screen.

6. Click End Meeting then click End Meeting for All. This will
end your meeting and start the upload process, so please stay

connected to the Internet.

Wl Rl

Start Video Manage Participants

New Share

1 V4

Pause Share  Annotate

(+)

More

Chat
Breakout Rooms

Invite

Pause Recording

Stop Recording

Disable Attendee Annotation

Audio Options...
Video Settings...

Optimize for full-screen video clip

End Meeting

If you want to keep this meeting open, please assign
another Host before you click Leave Meeting.

d like to give feedback to Zoom

Cance Leave Meeting
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Recording in Zoom

If you have chosen to Record to the Cloud, after you click on the End Meeting button, your recording will
automatically be uploaded to the ZOOM Cloud server.

If you have chosen to Record on this Computer, after you click on the End Meeting button, your recording will be
saved on your computer.
You can find your ZOOM recordings in a subfolder named ZOOM in your Documents folder.

> For more details, please check the following web sites:

System requirements for Windows, macOS, and Linux
https://support.zoom.us/hc/en-us/articles/201362023-System-requirements-for-Windows-macOS-and-Linux

Testing computer or device audio
https://support.zoom.us/hc/en-us/articles/201362283-Testing-computer-or-device-audio

Testing your video
https://support.zoom.us/hc/en-us/articles/201362313-Testing-your-video

How to Share your slides
https://support.zoom.us/hc/en-us/articles/201362153-Sharing-your-screen-content-or-second-camera

Local Recording
https://support.zoom.us/hc/en-us/articles/201362473-Local-recording
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